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Canadian (Ontario) Payroll Tax Tables—
September 2014 Update
The September 2014 update of Sage 100 Contractor—Canadian Edition includes new payroll tax tables
issued by the Canada Revenue Agency for the Province of Ontario. The new tax rates are effective
retroactive to January 1, 2014.

For information about these changes, see the Canada Revenue Agency website.

Canadian (Ontario) Payroll Tax Tables—September 2014 Update
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U.S. Payroll Tax Tables—July 2014
Updates
Government-Mandated Payroll Tax Changes
As a result of legislative changes, the payroll tax tables changed for the following jurisdictions:

l Idaho, retroactive to January 1, 2014

l Ohio, effective July 1, 2014

l Yonkers, New York, effective August 1, 2014

U.S. Payroll Tax Tables—July 2014 Updates
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Enhancements in Version 19.4
Youwill find the following new features and enhancements in Sage 100 Contractor Version 19.4.

General Improvements

Improved Project Management Information
The 6-12 Project Work Centerwindow now includes the request number in the Transaction# column for
Requests for Information.

Printing Support for Windows 8.1 and Windows Server 2012 R2
To support printing to PDF or RTF in aWindows 8.1 orWindows Server 2012 R2 environment,
version Version 19.4 includes version 5.0.1.1 of the Amyuni PDF Converter.

IMPORTANT: If you are upgradingSage 100 Contractor on aWindows 8.1 or aWindows Server
2012 R2machine, youmust take some additional steps to upgrade the PDF Converter before printing to
PDF or RTF. For more information, see Knowledgebase article 24875.

Enhancements for the Canadian Edition
Sage 100 Contractor Version 19.4 includes the following enhancements to the Canadian Edition:

Support for Vacation Accrual
Tomeet statutory requirements, Sage 100 Contractor now tracks the dollar balance of employee vacation
earned but not yet paid . Accrued vacation can be paid out with each pay cheque, or it can accumulate in a
payroll liability account to be paid out later.

The vacation balance is calculated and posted to a liability account for the employee whenever you final
compute payroll.

NOTE: Vacation is taxed when it is paid out, not when it is accrued.

We have updated several Sage 100 Contractor windows, as described in the next sections, to support the
new methods for accruing and paying out vacation.

Changes in the 5-3-1 Payroll Calculations window

You can now set up payroll calculations for accruing vacation using Tax Type 6 - Vacation Accrual.

For a new vacation accrual calculation, the default rate is 4%. If vacation is earned and accrued on vacation,
you calculate a different default rate by multiplying the recursive portion of the tax by the base rate. For
example, if employees accrue additional vacation at 4% on a basic accrual rate of 4%, you would enter 4.16 in
theDefault Rate field.

Enhancements in Version 19.4
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The Credit Account you use tomaintain the vacation balancemust be an account that is set up to use
subaccounts, and it cannot already have subaccounts associated with it. The check box Use employee# as
subaccount is selected automatically for vacation accruals, and you cannot change this selection.

Other payroll calculations can affect vacation calculations. A new Vacation Accrual check box in the
Subject to section of the window lets you control which taxable benefits or non-taxable deductions affect the
accrual amount.

When you upgrade to version 19.4, theSubject to Vacation Accrual check box is selected automatically for
existing payroll calculations if the calculation is subject to CPP contributions. You can change the Vacation
Accrual option at any time, although you cannot change any other Subject to options after saving a payroll
calculation.

CAUTION: If you have been tracking vacation accruals using payroll calculations with Tax
Type - None in earlier versions, you should either set the default rate for the old payroll calculation to
zero or set that calculation inactive before setting up the new Tax Type 6 - Vacation Accrual for payroll
calculations in version 19.4. Otherwise, vacation accruals and payouts may be counted twice.

TIP: To bring a new system up to date, you can enter the amount of vacation due that has already been
accrued.

Changes in the 5-2-1 Employees window

A new Accrued Vacation Due field on the Compensation tab of the 5-2-1 Employeeswindow keeps track of
each employee’s accrued vacation. This field is updated when you perform a payroll final compute. Similar to
the Advances Due field, the Accrued Vacation Due field is not cleared at year-end, but continues to
accumulate accrued vacation until vacation is paid out.

TIP: You can lock this field to suppress further edits after you save an employee record, if necessary.

This window also provides a new query, Employees~Accrued Vacation Due, that shows the vacation
balance for employees who have vacation due.

Changes in the 5-2-2 Payroll Records window

A new Vacation Payout field in the Payroll Records window allows you to enter a lump sum payout—or even
a negative amount—for a pay period. The field is available for all payroll types except advances for new or
existing open payroll records.

A display field labeled (Vacation balance is …) beside the Vacation Payout field shows the current vacation
balance accrued for the employee.

Together, the Vacation Payout and the Salary amounts make up the amount that appears as the total pay for
the period.

This window also provides a new query, Payroll Records~Vacation Payout, that shows a list of vacation
payouts for a specified range of employees and pay periods. You can drill down from this query to view the
underlying transaction for a selected payout.

Enhancements in Version 19.4
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Changes in the 5-2-3 Compute Payroll window

During a final payroll computation, any vacation accrued for the period increases theAccrued Vacation Due
field in the employee record. Any vacation payout reduces the amount in theAccrued Vacation Due field in
an employee’s record.

NOTES:
l Vacation is not accrued on any vacation payout amount.

l While Sage 100 Contractor does not automatically audit or verify the vacation amounts, you can
query the accrued vacation for all employees in the 5-2-1 window, and then compare the amounts
on the resulting report to the subsidiary balances in the liability account.

Changes in the 5-2-6 Post Payroll to GL window

Vacation payout is posted as a debit to the liability account specified for the accrued vacation payroll
calculation, using the employee# as the subaccount.

Vacation accrual is posted as a credit to the liability account specified for the accrued vacation payroll
calculation, using the employee# as the subaccount.

New and Improved Payroll Reports
Version 19.4 includes new reports that can help youmeet federal and provincial filing requirements, as well as
modified reports that support the changes in vacation processing.

New Employer Health Tax (EHT) Report

The 5-1-4 Provincial Tax Reportwindow includes a new 71 - Employer Health Tax report, which you can
use when you complete your Employer Health Tax (EHT) return in provinces that require this filing. The report
lists the taxable gross, computed EHT, and EHT liability for each employee.

Before you can run the report, you need to set up a payroll calculation for Employer Health Tax, and assign it
to employee records. When printing the report, you specify the Employer Health Tax payroll calculation.

NOTE: There is no dedicated tax type for Employer Health Tax, but you can use Tax Type = None.

Gross Wage Totals for Federal and Provincial Tax Reports

When printing Federal Tax reports and Provincial Tax reports, you can select the new Use Taxable Gross
option to exclude from gross wages any benefits, allowances, and deductions that are not subject to tax.
These exclusions can include, for example, overtimemeal allowances, reimbursement of moving expenses,
or union dues.

l If you select theUse Taxable Gross check box, the tax report includes a Taxable Gross column that
displays only wages on which income tax is calculated.

l If you do not select this check box, the tax report includes a Total Gross column that displays all
wages, which can include non-taxable benefits, allowances, and deductions.

Enhancements for the Canadian Edition
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New Combined Federal/Provincial Tax Reports

The 5-1-3 Federal Tax Reportwindow includes two new combined Federal/Provincial tax reports:

l 41 - Federal/Provincial Tax Report~Excluding Quebec. This reports lists income tax, CPP, and EI
totals paid by and for each employee, as well as the taxable gross for each employee, for all provinces
except Québec. You can use it when filling out the PD7A remittance report for the Canada Revenue
Agency.

l 42 - Federal/Provincial Tax Report~Quebec Only. This report lists Québec income tax, QPP, and
EI totals paid by and for each employee in the province of Québec, as well as the taxable gross for
each employee listed. You can use it when filling out the RLZ-1.S-V Summary of Source Deductions
and Employer Contributions report for RevenuQuébec.

Redesigned 5-2-4-21 Payroll Cheques Include Vacation Amounts

Wehave redesigned the payroll cheque stubs to include new Vacation Payout andVacation Balance
amounts, reflecting the amount of vacation paid and the amount still owed to employees.

Redesigned Payroll Processing Reports Include Accrued Vacation

The 5-2-1 Payroll Processing reports 21, 22, 31, and 32 include theAccrued Vacation Due amount.

Improved Sales Tax Calculation and Tracking
Version 19.4 introduces several changes that make Sage 100 Contractor more flexible and evenmore
responsive to the variety of sales tax requirements in different Canadian jurisdictions, including the following:

l You can now createmultiple tax codes for provinces that levy several taxes, resulting in more refined
tax reporting. For example, you can create a Tax Exempt tax code for vendors that are exempt from
tax, and you can create another code for goods and services that are subject to input tax credit
recapture.

l Sage 100 Contractor can now compute and track Recaptured Input Tax Credits (RITC) on Accounts
Payable invoices and credit notes for provinces that have HST.

l OnAccounts Receivable invoices and Service Receivable invoices, you can now override calculated
sales taxes with a dollar amount, allowing you to process accurately invoices that were created
outside Sage 100 Contractor (for example, by a salesperson or a subcontractor on the road or at a job
site, or during setup).

l In Accounts Payable, when entering credit card receipts, you can now enter a total amount and let
Sage 100 Contractor compute the correct tax based on the vendor's jurisdiction. This feature is useful
when recording receipts that do not show individual tax amounts.

Support for Multiple Sales Taxes

Some provinces have a variety of tax rates that apply to different types of goods and services, or they may
exempt certain types of businesses or services from tax. With version 19.4, you can createmultiple tax codes
for each province. For example, you could create additional tax codes for provinces that apply special tax
rates to certain items. Because you no longer need to enter a tax rate for GST or HST, you can also set up tax

Enhancements in Version 19.4
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codes for tax-exempt vendors. You can also set up special tax codes for provinces that require the recapture
of input tax credits on specified property and services.

You use theCanada Sales Tax Setup table in the 1-8 General Ledger Setupwindow to set up the
additional tax codes.

IMPORTANT: When definingmultiple tax codes for a province, youmust assign an identical set of
accounts to each tax code for the province.

Where there aremultiple tax codes for a province, a new Is Primary Code column in the tax setup table
indicates which tax code Sage 100 Contractor uses as the primary tax code for the province. The primary tax
code is used as the default for Accounts Payable transactions for each province. However, you can override
this code for specific transactions and vendors.

NOTE: During the upgrade to version 19.4, Sage 100 Contractor automatically marks existing provincial
tax codes as the primary codes for each province.

Tax Codes for Foreign Vendors

The 9999--Unidentified Province tax code now uses "ZZ" as the Province code, which the Canadian
Revenue Agency recognizes as the code for vendors located outside Canada.

Overriding the Primary Tax Code for Specific Vendors

Sometimes, youmay need to assign a tax code to a vendor that is different from the primary tax code for the
vendor's province. In version 19.4, you can define secondary tax codes that use different tax rates, or a zero
tax rate (for tax-exempt vendors). You can then assign these secondary codes to individual vendors.

To override the primary tax code for a specific vendor, you enter the correct code in the new Tax Code
Override in the 4-4 Vendorswindow.

When you enter Accounts Payable transactions in the 4-2 Payable Invoices/Credits, 4-6 Recurring
Payables, and 4-7-3 Credit Card Receiptswindows, Sage 100 Contractor automatically applies the tax
code override from the vendor record, if one is specified for the vendor. If no tax override is specified in the
vendor record, the primary tax code for the province is used.

Changes in Transaction Windows to Support Multiple Tax Codes

In Accounts Receivable, the 3-2 Receivable Invoices/Credits, 3-7 Progress Billing, 3-9 Unitary Billing,
and 3-10-4 Post T&M Invoiceswindows calculate sales tax based on the primary tax code for the province
used for the job.

In Service Receivables, the 11-2 Work Orders/Invoices/Creditswindow calculates sales tax using the
primary tax code for the province specified for the service location. However, you can override tax amounts
for individual detail lines.

In Accounts Payable, the following transaction windows include new tax code fields:

l 4-2 Payable Invoices/Credits

l 4-6 Recurring Payables

Enhancements for the Canadian Edition
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l 4-7-3 Credit Card Receipts

l 4-7-4 Enter Recurring Charges

When you select a vendor in these windows, Sage 100 Contractor inserts the tax code from the vendor record
as the default code in the transaction header and detail lines. If no tax override exists for the vendor, it uses
the primary tax code for the vendor’s province. Sage 100 Contractor follows these same principles when
inserting tax codes in the header and detail lines on invoices created from purchase order receipts and credit
card receipts. The tax rates for the specified tax code are applied to the transactions.

You can change the tax code in the transaction header, and you can change the tax codes and the tax
amounts in detail lines. However, the tax codes used in the grid must be defined for the same province as the
tax code used in the header.

IMPORTANT: Overriding tax codes and amounts for detail lines has an impact on federal tax reports.
Entering a zero tax amount for a detail line is not equivalent to using a tax-exempt tax code. Transactions
that use a tax-exempt tax code do not appear on the GST/HST report. Transactions that contain a zero
override amount do appear on the GST/HST report, and they show that no tax was paid.

NOTE: When upgrading existing payable invoices and recurring payables to version 19.4, Sage 100
Contractor automatically updates the headers using the primary tax code for the vendor's province.
Similarly, it updates existing recurring credit card charges using the primary tax code for the payee's
province.

Recaptured Input Tax Credits

Sage 100 Contractor can now track, compute, and report Recaptured Input Tax Credits (RITC) for provinces
that have HST and require large businesses to repay input tax credits on specified goods and services.

NOTE: The RITC fields are used only for internal tracking and reporting of disallowed input tax credits
that are accumulated from Accounts Payable transactions. They do not appear in Accounts Receivable,
and you will not find them on your vendors' original documents.

Changes in General Ledger to Support RITC

You can define secondary provincial tax codes specifically to track RITC, and then enter the RITC tax code in
Accounts Payable transactions to which RITC applies.

You use theCanada Sales Tax Setup table in the 1-8 General Ledger Setupwindow to define RITC tax
codes. The tax setup table now includes RITC Rate andRITC Paid Account columns that you use to
specify the repayment rate and posting account for recaptured tax credits.

Changes in Accounts Payable to Support RITC

The 4-2 Payable Invoices/Credits and 4-7-3 Enter Credit Card Receiptswindows display tax amount
columns only for the tax code specified in the transaction header (usually, the primary tax code for the
vendor's province):

A new RITC column appears for provinces with HST. An RITC amount is calculated for each detail line.

Enhancements in Version 19.4
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NOTE: In the 4-6 Recurring Payables and 4-7-4 Recurring Credit Cardswindows, you cannot use a
tax code that includes an RITC rate.

Changes to GST/HST Filing Reports to Support RITC

TheGST/HST Filing reports (2-11-21 and 2-11-22) now include a PST/RITC column. (In provinces that have
HST, only RITC amounts appear in the PST/RITC column. In provinces that have PST, only PST amounts
appear in this column.)

Override for Receivable Sales Tax Amounts

You can now override the tax amount when you enter receivable invoices created in another system (such as
during setup) or createdmanually.

To override the sales tax amount in the 3-2 Receivable Invoices/Creditswindow or in the 11-2 Work
Orders/Invoices/Creditswindow, select Options > Override Sales Tax Amount. You can then enter tax
amounts directly in the grid.

CAUTION: If you choose to override sales tax amounts, the program will not calculate or verify any tax
amounts in the grid for the current transaction.

The override applies only to the current transaction—it will not carry over into the next transaction.

Sales Taxes Derived from Credit Card Receipt Totals

The 4-7-3 Credit Card Receiptswindow provides a convenient way to enter a credit card receipt that does
not show tax amounts. You can now simply enter the total receipt amount (including tax), and let Sage 100
Contractor calculate the tax amounts for you.

Before entering other detail lines, simply enter the total receipt amount in the new Optional Total Receipt
field, and then click the adjacent Calculate button to add a detail line that includes tax amounts calculated for
the specified tax code.

Additional Improvements
More Flexible Tax Codes for Accounts Payable

In the 4-4 Vendorswindow, the Invoice Defaults tab includes a new Tax Code Override field, which you can
use to override the primary tax code used for the vendor's province.

If you add a tax code that has no tax rate in the 1-8 Canada Sales Tax Setupwindow, you can then assign
that tax code to vendors that are tax exempt.

Enhancements for the Canadian Edition
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Enhancements in the September 2014 Release

If you use the API…

IMPORTANT: This update includes database changes. Therefore, if you use the API, youmust re-
index all companies using the 7-4 Rebuild Indexeswindow after installing the September 2014 update.
(Because the version number has not changed with this update, the 7-5 Update Databaseswill not
rebuild indexes automatically.)

Flexible date formats for the Canadian Edition
You can now use the United States date format (mm/dd/yyyy) for your company if you prefer not to use the
default format for Canada (dd/mm/yyyy). You choose the United States format by selecting a new Use
mm/dd/yyyy Date Format check box in the 7-2 Company Informationwindow, on the Options menu.

When you select the check box, all data entry screens and reports will use the United States date format,
except dates on cheques, which continue to use the special Canadian date format (consistent with our
cheque stock and Canadian requirements). The stub portion on a cheque will use the date format specified in
the 7-2 Company Informationwindow.

NOTE: After you switch the date format, Sage 100 Contractor will not be able to interpret existing event
logs that use the old format. The next time an event or scheduled report is executed, Sage 100
Contractor renames the associated existing event log, and starts a new event log, which it can read even
if you change the date format again.

TIP: If you need to refer to them later, you can find old event log files (*EventLogOld) in the Sage 100
Contractorsubfolder in your local AppData folder—for example,
C:\Users\Username\AppData\Local\Sage\Sage 100 Contractor\ProgramAlertsEventLogOld. You can
open these files with any text editor, such as Notepad.

IMPORTANT: Youmust rebuild indexes after installing the September 2014 update to activate this new
check box.

Resetting formats for dates used in alerts, warnings, and report defaults

If you change the date format in the 7-2 Company Informationwindow, you will need tomanually update any
dates used in alerts, program warnings, and report selection criteria saved as defaults.

For example, if you have saved defaults for printing a report that includes a date you specify at print time, and
then you change the date format for the company, youmust reset the report defaults to use a date format that
the report can process.

To reset the report defaults:

1. Delete the existing defaults.

2. Enter the date in the proper format.

Enhancements in Version 19.4
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3. Save the updated report defaults.

Displaying the date format on printed reports

To show which format is used for dates printed on a form design, you can add a global calculated field to the
form design to show which date format is used on the printed report. If you add the CP^dtefmt (or
cmpany^dtefmt) date field to a form design, when you use the form design to run a report, the header in the
printed report (or PDF) will indicate the format your company uses for dates. In this example, the line "
(mm/dd/yyyy)" indicates that the date is August 12th, not December 8th:

Form Design Printed Report

<<CP^>> AR Invoice List

<<CP^curdte>> 08/12/2020

<<CP^dtefmt>> (mm/dd/yyyy)

CAUTION: These calculated fields can be used only on form designs. Inserting them in report details
will corrupt the report, causing it to fail when you try to print it.

NOTE: The date format field is provided for your convenience, and is optional.

Enhancements in the September 2014 Release
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Fixes in Version 19.4
Wehavemade the following software fixes in the first release of Version 19.4.

n In the 10-3 Scheduleswindow, if you change the fixed date for a task that has a predecessor in another
phase, when you click the Recap button, you receive amessage that lists the jobs and phases affected by
your change. Youmust recalculate and save those jobs and phases before you can display the Scheduling
Recap window.

n In the 3-10-2window, the computation of time andmaterials invoices for a range of jobs now skips jobs that
are not time andmaterials jobs, and continues processing.

n In the 3-1-8-31window, the JobMail Label~ Sheet can now export job information to Excel.

n In the 5-2-1 Employeeswindow, theSocial Security# field (in the U.S. Edition) and theSocial
Insurance# field (in the Canadian Edition) respect the Require Unique property when it is set for the field.

n If you posted LIFO/FIFO inventory consumption to the year prior to the year you posted the stocking
transaction, archive validation will display an inventory audit error that can be fixed.

n In the 1-3 Journal Transactionswindow, you can no longer use the Quick List to overwrite text fields on
posted Accounts Payable check transactions.

n In the 9-5 Takeoffswindow, you can now export takeoff prices to the parts database regardless of the
options selected on theOptions menu.

n In the 5-2-2 Payroll Recordswindow, if you enter a timecard that has a salary amount, but total hours
equal zero in the grid, the program no longer computes job costs..

n In the 4-2 Payable Invoices/Creditswindow, you can now void an invoice for a PO that included a line
with no parts or amounts.

n If the 11-2 Work Orders/Invoices/Creditswindow does not require unique service order numbers and you
happen to reuse the number of a void service order, you can now enter that service order number in a payroll
record. The program ignores the void service order number, and proceeds to validate subsequent service
orders.

n In the 10-3 Scheduleswindow, when you use theGrid/Gantt window to change the duration of a task, the
Gantt Chart is updated to reflect the change when you save the schedule.

n In the 11-3 Dispatch Boardwindow, you can now leave theWork Order Propertieswindow open while
you copy several notes from another program and paste them in theWork Order Propertieswindow. You
no longer have to save and close the notes each time you leave theWork Order Propertieswindow to
copy a note from the other program.

n The 5-1-1-21 Employee List report now correctly displays employees' social security numbers (social
insurance numbers, in Canada) when you print or preview the report.

Fixes in Version 19.4
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n When archiving a fiscal year in the 1-6 Period/Fiscal Year Managementwindow, if inventory audit errors
cause the verification process to fail, all the contents of the archive folder are deleted properly.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n The T5018 Recipient TIN is sent to Aatrix correctly when the vendor T5018 is Business (2).

n The HST on non-vendor-related payments are now included on the 2-11-0-21 report .

n In the 5-3-1window, theExclude from T4 slips box is available.

n Aatrix reports that include Charitable Donations, Union Dues and RPP Contributions are now correct when
the Tax Type is 0-None.

n In the 1-8 General Ledger Setupwindow, the pre-built General Contractor and Subcontractor charts of
accounts now use the correct Workers' Comp Payable account.

n Default discount calculations now use the correct base amounts. In the 4-2 Payable Invoices/Credits
window, discounts are based on the invoice amount net of tax. In the 3-2 Receivable Invoices/Credits
window, discounts are based on the invoice amount net of holdbacks.

n The taxable gross amounts on the 5-1-4-21, 22. 31, and 32 Provincial Tax reports now match the taxable
gross on the Federal Tax report.

n In the 3-11 Recurring Receivables window, when you enter a job without specifying the province, you
receive only onemessage informing you that sales cannot be computed unless you specify a province.

n When you print a statement in the 3-4 Statementswindow, the Total Invoiced to Date amount now
includes billed holdbacks.

n Long Vendor Lists you print using the 4-1-1 Report Printingwindow now include the correct label for the
GST/HST ID# field.

n Outstanding Balance amounts are now correct on all Subcontract Audit reports printed using the 6-7-4
Report Printingwindow.

n The 5-3-7 Payroll Auditwindow no longer displays a CPP audit errors for an employee that has a very
small wage total for the year.

n CPP is now calculated correctly for employees not yet 18 years of age and for employees over the age of
70.

Fixes for the Canadian Edition
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Fixes—Version 19.4 August 2014
Update
Wehave fixed the following issues in the August 2014 product update for Sage 100 Contractor Version 19.4:

n When you final compute payroll, job costs are now created for timecard entries that use only Pay Type 7-
Piece Pay.

n When you final compute payroll, job costs are now created for timecard entries to and from jobs (+/-), where
the net Pay amount is zero.

IMPORTANT: This update does not createmissing job costs retroactively. If you have not entered the
missing job costs manually, contact Customer Support for assistance after you apply this update.

n The 5-2-2 Payroll Recordswindow no longer displays a warningmessage when you save a payroll record
that references a unique Service Order unless the order number is Void.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n In the 11-2 Work Orders/Invoices/Creditswindow, if you override the sales tax amount on a work order
for a client subject to GST, the program no longer rounds the amount you enter in theGST Amount column.

NOTE: To activate this fix, youmust first use the 7-4 Rebuild Indexeswindow to rebuild indexes for all
tables.

Fixes—Version 19.4 August 2014 Update
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Fixes—Version 19.4 September 2014
Update
Wehave fixed the following issues in the September 2014 product update for Sage 100 Contractor Version
19.4:

n If you do not specify period/year criteria for the 6-1-4-71 Job Income Statement report, the report includes
all records from the current fiscal year and later. The report correctly filters records by phases, even if you
select theExclude Previous Years option.

n In the 4-2 Invoices/Creditswindow, you can set the status of an invoice to Open when the associated PO
receipt includes a line with zero quantity received, and you no longer receive an error message when you
save the invoice.

n The 5-5-1 Daily Payroll Entrywindow no longer displays a warning when you post an entry that includes a
reused work order number if the original work order number was voided and unique order numbers are not
required in the 11-2 Work Order/Invoices/Creditswindow.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n In the 5-2-1 Employees and the 5-3-1 Payroll Calculationswindows, if you enter an incorrect rate for
2014 ER Employment Insurance, when you save the record, amessage displays the correct rate, using
four decimal places rather than two, for EI, Quebec EI, CPP, andQPP.

n When you copy and paste a record in the 5-2-2 Payroll Recordswindow, the vacation balance in the new
record is refreshed immediately.

n The 5-2-2 Payroll Recordswindow no longer creates job costs for vacation that you pay out on a timecard.

n In the 9-2 Partswindow, the average cost is now correctly computed for parts from Accounts Payable
invoices that include PST.

Fixes for the U.S. Edition
The following issues were fixed specifically for the U.S. Edition of Sage 100 Contractor:

n The 5-1-5-21 Worker's Comp report now clearly groups Worker's Compensation amounts by job if you
select theSeparate Report By Job option.

Fixes—Version 19.4 September 2014 Update
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Known Issues and Comments
The following sections describe known issues and problems in Sage 100 Contractor Version 19.4.

General

Internet Access Required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling tax forms, submitting enhancement requests,
accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is
installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to
connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for
each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the
Internet.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction
Anywhere..

For current information on supported browsers, supported Sage 100 Contractor versions, and other system
requirements, see the Sage Construction Anywhere help at
http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_
requirements.htm.

Sage Advisor Update
Sage Advisor Update is a notification and download service that alerts you when an update is available for
Sage 100 Contractor. You can also use Sage Advisor Update to download updates for your Sage products.

TIP: Use theCustomize settings in theWindows system tray tomake sure you can view the Sage
Advisor Update icon and notifications from the System Tray in your Taskbar.

For more information about Sage Advisor Update, see "About Sage Advisor Update" in the User Guide and in
the Sage 100 Contractor help.

Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

l For updating forms and executable files.

l For electronic filing (eFiling) of the forms.

Both of the operations listed can report an Internet connection problem. The vast majority of these problems
are a result of problems communicating through an Internet firewall.

Firewalls need to have access allowed through specific ports:

Known Issues and Comments
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l The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site
http://updates.aatrix.com.

l The eFiling component uses secure HTTPS on port to access the site https://efile.aatrix.com.

By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter
and only allow access to these ports by specific programs. Tax Forms and eFiling uses the following
programs to access the Internet.

For updating using http on port 80 to http://updates.aatrix.com:

l aatrixforms.exe

l updater.exe

l updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:

l builder.exe

l viewer.exe

Locating tax updates
Tax updates are released throughout the year. To get the latest information about tax updates:

1. Log on to the Customer Portal, https://support.na.sage.com/.

2. In theSolve a common problem section, click Sage Contractor Downloads and Updates.

Printing reports at year-end (U.S. Edition)
As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then
you print a 4 1 3 26 AP Aging report for the prior year, the report shows a reduced Retention amount, and the
amount paid in the future period is allocated to the Current period or an aging period, depending on the due date
of the retainage and the date it was paid.

Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of
reports that reflect the true amount of retainage outstanding at year end.

TIP: If you archive your data at year end, you can also print the reports from the Archive, later.

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by themajor credit
card companies as a guideline to help organizations that process card payments to prevent credit card fraud,
cracking, and other security weaknesses and threats.

General
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A company processing, storing, or transmitting payment card datamust be PCI-compliant or risk losing its
ability to process credit card payments and being audited and/or fined. (For more information about PCI
standards, see https://www.pcisecuritystandards.org/.)

Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable
merchants to seamlessly process check and credit card transactions directly in Sage 100 Contractor. The
payment processing program uses Sage Exchange, a secure payment-processing application, to connect to
Sage Payment Solutions and process check and credit card transactions.

Integrating your financial and operations system with Sage Payment Solutions lets you process check and
credit card transactions without storing your customers’ sensitive card information in your database. Sage
Exchange transmits check and credit card details through a secure connection to Sage Payment Solutions,
where they are stored in a PCI-compliant vault, protecting your from exposure to non-compliance penalties
and credit card fraud.

CAUTION: To avoid non-compliance with PCI standards, do not store credit card information in Sage
100 Contractor. Such storage also creates unnecessary risk for your business and your customers.

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier
than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing fromWindows and from Sage 100
Contractor.

IMPORTANT: To fax from Sage 100 Contractor, theWindows Fax Service component must be
installed with yourWindows operating system. For more information about installing theWindows Fax
Service component, see the Sage 100 Contractor Help topic, “Installing theWindows Fax Service
component.”

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable
communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port
48750. Certain configurations can potentially disable the communication:

l File sharing on computers running theWindows 8, Windows 7, Vista, Server 2008, Server 2008 R2,
and Server 2012 operating systemmust be enabled. To enable file sharing, follow the instructions in
theWindows Help.

l TCP communication requires the selection of port numbers that are not in use by other processes on
the local computer.

l Software firewalls running on the local computer can be configured to block processes from opening
TCP ports, which will prevent communication through the TCP Remoting Channel.

Known Issues and Comments
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Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 8, Windows 7 Professional, Vista, Server 2008, or
Server 2008 R2 Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 8, Windows 7 Professional, Vista Business, Server 2008, or Server 2008 R2 Standard
operating systems. If the service stops, the program displays amessage advising you to take further action to
resolve this issue.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, theWindows Firewall is configured
automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some
other firewall, however, youmay need tomanually adjust some settings in the firewall in order to ensure
proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the Sage 100
Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually
configuring other third-party firewall products.

To configure the Windows Firewall:

1. ForWindows Vista or Server 2008, click Start > Control Panel > Security.

ForWindows 7, click Start > Control Panel > System and Security

ForWindows 8, click Start > All apps > Control Panel > System and Security.

2. OpenWindows Firewall, and then select Allow a program or feature through Windows Firewall.

3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selectingAdd
Program, then browsing to the following path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

NOTE: By default, the exception is set to allow access by any computer on the network. You can refine
this setting by selecting theChange Scope button. Be aware that restricting the scope incorrectly can
cause the computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8 Professional 32-
bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software
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l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional 64-
bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 64-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-
bit

l C:\MB7
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l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-
bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2008, 2011,
2012

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software
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l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Configuring Windows Regional and Short Date Format
To specify regional formats for Windows:

1. Click the [Start] button, point toControl Panel, then click Clock, Language, and Region .

2. Click Region and Language.

3. On the Formats tab, select the format for your country.

4. UnderDate and time formats, from the Short date format drop-down list, select the format used for your
country.

5. Click [OK].

6. Close theClock, Language, and Regionwindow.

Windows 8 Professional and Server 2012 Standard Operating
Systems

Windows 8 Professional and Server 2012 Standard "Sleep Mode"
prevents computers from obtaining a license use
If a computer running theWindows 8 Professional or Server 2012 Standard operating system is used as a
license server, when it goes into sleepmode other computers on the network can’t obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > All apps > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 8
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 8 Professional orWindows 8 Enterprise operating systems. If the service stops, the
program displays amessage advising you to take further action to resolve this issue.
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Solution for Server 2012 error message about mb7.kpr file
If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a
computer runningWindows Server 2012, follow these steps to resolve the issue:

1 On theWindow desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click theMB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click the [Security] tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Server 2012 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable
communication among computers on a network. File and printer sharing on computers running the Server
2012 operating systemmust be enabled. To enable file sharing, follow the instructions in theWindows Server
2012 Help.

Windows 7 Professional and Server 2008 R2 Standard
Operating Systems

Launching Sage 100 Contractor to run as administrator for scheduling
reports

IMPORTANT: On computers runningWindows 7 Professional or Server 2008 R2 Standard, scheduling
Sage 100 Contractor reports requires that you “run as administrator” or to “run the program as
administrator.”

Microsoft Windows has changed security rules in theWindows 7 Professional and Server 2008 R2 Standard
operating systems tomake your computer more secure. If you are running Sage 100 Contractor as a typical
user, then you have limited privileges in some areas of the program, such as saving a report schedule. To
save a report schedule, youmust launch Sage 100 Contractor with the command to eitherRun as
administrator orRun this program as an administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100
Contractor as administrator do not affect the next person who logs on and launches Sage 100 Contractor from
this computer. Your settings on this computer can either be temporary or persistent. For example, when you
select Run as administrator, you run the program as administrator for that session only. When you select Run
this program as an administrator, you set program properties to always run the program as administrator
when you log on to this computer.

Windows 7 Professional and Server 2008 R2 Standard Operating Systems
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NOTE: "Run as administrator" and "Run this program as an administrator" are not related to
Windows 7 Professional or Server 2008 R2 Standard operating systems user groups but are limited to a
specific program you are running.

To set "Run as administrator":

1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, to launch the program, click [Run as administrator].

NOTE: SelectingRun as administrator only runs the current session of running Sage 100 Contractor.
The setting does not persist after the session is over.

To set "Run this program as an administrator":

1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, click [Properties].

3 On the Sage 100 Contractor Properties window, click the [Compatibility] tab.

4 Under Privileges Level, select Run this program as an administrator.

5 Click [Apply], and then click [OK].

NOTE: SelectingRun this program as an administrator always runs the program with these
properties when you launch the program on this computer. The setting persists.

Windows 7 Professional, Windows 8 Professional, and Server 2008 R2
Standard "Sleep Mode" prevents computers from obtaining a license use
If a computer running theWindows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system
is used as a license server, when it goes into sleepmode other computers on the network can’t obtain a
license.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Windows Server 2008 R2 and Microsoft .NET 3.5.1
Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on aWindows
Server 2008 R2machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100
Contractor doesn’t install it automatically.
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If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following
message during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”
When you click [OK], the installation continues, but the services have not been installed so Sage 100
Contractor cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has
been installed. If you receive the abovemessage during installation, install .NET Framework 3.5.1 and
reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:

1 Click theStart button in the lower left corner of the display.

2 Highlight Administrative Tools and select Server Manager.

3 In theServer Manager interface, click Features to display all the installed Features in the right-hand pane.
Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:

1 In theServer Manager interface, select Add Features to display a list of possible features.

2 In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3 Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to
.NET Framework 3.5.1 and click Next.

4 In theConfirm Installation Selections interface, review the selections and then click [Install].

5 Allow the installation process to complete and then click [Close].

NOTE: Enabling .NET Framework 3.5.1may require a reboot.

Solution for Server 2008 R2 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running the
Windows Server 2008 R2 operating system, follow these instructions:

1 On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2 On the left side of the window, underComputer > Local Disk, right-click the \MB7 folder, and then select
Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, and then click theEdit button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.

6 Selecting Full control selects all the check boxes necessary for this solution.

7 On thePermissionswindow, click OK, and then on theMB7 Propertieswindow, click [OK].

Windows 7 Professional and Server 2008 R2 Standard Operating Systems
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Solution for Windows 2008 Server R2 Application Error Message
Under some circumstances, on servers operatingWindows 2008 Server R2, youmay experience the
following error message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."

This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not
yet enabled the Desktop Experience feature inWindows 2008 Server R2. If you receive this error message,
install Desktop Experience using the Server Manager utility:

1 InWindows 2008 Server R2, select Start > All Programs > Administrative Tools > Server Manager.

2 In theServer Managerwindow, click Features (left-hand pane).

3 In the Features pane, click Add Features.

4 Select the Desktop Experience check box.

5 If you are prompted to add additional features, click [Add Required Features].

6 Click [Next].

7 Click [Install].

Windows Vista and Server 2008 Operating Systems

Solution for Server 2008 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running the
Windows Server 2008 operating system, follow these instructions:

1 On theWindow desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click the \MB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.
Selecting Full control selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].
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Vista and Server 2008 “Sleep Mode” prevents computers from obtaining
a license use
If you are using a Vista or Server 2008 computer as the Sage license server and it goes intoSleep Mode, the
workstations cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can
be used in place of Vista or Server 2008.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to "Never":

1 Start > Control Panel > System and Maintenance > Power Options.

2 Select Change when computer sleeps.

3 From thePut computer to sleep list, select Never.

Vista, Windows 7, and Server 2008 and changing the Sage License
Server computer
On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server >
Select the computer from the list of computers on your network, the commandmay fail to generate a list
of network computer names. To resolve this issue, click Enter the IP address or name of the computer,
and then type the IP address of the server computer in the box.

Possible conflict when running scheduled reports on Vista Business 64-
bit operating system
On computers running the Vista Business operating system, the Sage 100 Contractor report scheduler may
encounter a conflict with theMicrosoft print spooler (splwow.exe) andmay not function as expected.

A solution for avoiding this possible conflict would be to schedule reports on computers running a 32-bit
operating system.

Windows Vista and Server 2008Operating Systems
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